
 1 

CHƯƠNG 1 

TỔNG QUAN VỀ XỬ LÝ ẢNH VÀ PHẦN MỀM ADOBE PHOTOSHOP 

 

1.1 Các khái niệm cơ bản 

Pixel (phần tử ảnh - điểm ảnh): Trong thực tế ảnh liên tục về không gian, về giá trị 

độ sáng. Để có thể xử lý ảnh bằng máy tính cần thiết phải tiến hành số hóa ảnh. 

Trong quá trình số hóa người ta biến đổi các tín hiệu liên tục sang tín hiệu rời rạc 

thông qua quá trình lấy mẫu và lượng hóa về thành phần giá trị mà về nguyên tắc 

mắt thường không phân biệt được hai điểm kề nhau. Trong quá trình này người ta 

sử dụng khái niệm Pixel. Như vậy một ảnh là một tập hợp các Pixel. Số Pixel tạo 

nên một ảnh gọi là độ phân giải. 

Một ảnh chứa càng nhiều Pixel thì chất lượng ảnh càng cao. 

1.1.1 Biểu diễn ảnh 

Trong biểu diễn ảnh, người ta thường dùng các phần tử đặc trưng của ảnh là Pixel. 

Khi biểu diễn ảnh cần chú ý đến tính trung thực của ảnh hoặc các tiêu chuẩn 

“Thông minh” để đo chất lượng ảnh hoặc tính hiệu quả của các kỹ thuật xử lý ảnh. 

1.1.2 Tăng cường – Khôi phục ảnh 

- Tăng cường ảnh là bước quan trọng, tạo tiền đề cho xử lý ảnh. Nó gồm một loạt 

các kỹ thuật như: lọc độ tương phản, khử nhiễu, nổi màu… 

- Khôi phục ảnh: là nhằm loại bỏ các suy giảm trong ảnh. 

1.1.3 Biến đổi ảnh 

- Biến đổi ảnh nhằm chuyển đổi sự biểu diễn ảnh từ một không gian ban đầu sang 

một không gian khác sao cho việc xử lý được tiện lợi hơn. 

1.1.4 Phân tích ảnh 

- Phân tích ảnh liên quan đến việc xác định các độ đo định lượng của một ảnh để 

đưa ra một mô tả đầy đủ về ảnh. Sử dụng các kỹ thuật nhằm mục đích xác định 

biên của ảnh. Có nhiều kỹ thuật khác nhau như lọc vi phân hay dò theo qui hoạch 

động. Người ta cũng dùng các kỹ thuật để phân vùng ảnh. Từ ảnh thu được, người 
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ta tiến hành kỹ thuật tách hay hợp dựa theo các tiêu chuẩn đánh giá như màu sắc 

cường độ. Phải kể đến kỹ thuật phân lớp dựa theo cấu trúc của ảnh. 

1.1.5 Nhận dạng ảnh 

- Nhận dạng ảnh là quá trình liên quan đến các mô tả đối tượng mà người ta muốn 

đặc tả nó. Quá trình nhận dạng ảnh thường đi sau quá trình trích chọn các đặc tính 

chủ yếu của đối tượng. Trên thực tế người ta đã áp dụng kỹ thuật nhận dạng ảnh 

khá thành công với nhiều đối tượng khác nhau như: nhận dạng vân tay, nét chữ… 

1.1.6 Nén ảnh 

- Dữ liệu ảnh cũng như các dữ liệu khác cần phải lưu trữ hay truyền đi trên mạng. 

Lượng thông tin biểu diễn cho một ảnh là rất lớn. Do đó làm giảm lượng thông tin 

hay nén dữ liệu là một nhu cầu cần thiết. Có nhiều phương pháp nén dữ liệu đã 

được nghiên cứu và áp dụng cho loại dữ liệu đặc biệt này. 

- Nén dữ liệu là quá trình làm giảm dung lượng thông tin “dư thừa” trong dữ liệu 

gốc và do vậy lượng thông tin thu được sau nén thường nhỏ hơn dữ liệu gốc rất 

nhiều. 

- Trong nén ảnh, người ta dựa trên “tâm lý thị giác”, lợi dụng tính chất của mắt 

người, chấp nhận một số vặn xoắn trong ảnh khi khôi phục lại. 

1.1.7 Cấu trúc ảnh 

Trong quá trình phát triển của công việc lưu trữ đã phát sinh rất nhiều cấu trúc file 

ảnh khác nhau. Hiện nay có rất nhiều loại cấu trúc ảnh khác nhau trong lĩnh vực xử 

lý ảnh nhưng phổ biến hơn hết có thể nói tới một số cấu trúc sau: 

+ Photoshop (.psd) là dạng thức riêng của Photoshop, cũng là dạng thức tối ưu khi 

chúng ta làm việc trong Photoshop. 

+ Bitmap (.bmp): dạng thức này tương thích với windows, nó có tính không tổn 

thất nghĩa là không có dữ liệu nào của tập tin bị loại bỏ khi chúng ta lưu tập tin. 

+ EPS (.eps): dạng tập tin Encapsulated PostScript là một lựa chọn lý tưởng cho 

ảnh nét đen trắng. 
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+ GIF (.gif): Graphics Interchange Format. Dạng thức trao đổi đồ họa và hiển thị 

tuyệt vời cho web. Là dạng thức được thiết kế nhằm giảm kích thước tập tin và 

thời gian truyền tải trên web. 

+ JPEG (.jpg) Joint Photographic Experts Group được dùng để hiển thị ảnh chụp 

và ảnh tông màu liên tục trong các tài liệu HTML trên World Wide Web và các 

dịch vụ trực tuyến. Loại định dạng này lưu tập tin mà dữ liệu hình ảnh sẽ bị loại bỏ 

bớt nhằm giảm kích thước. 

+ PCX (.pcx) dạng thức được dùng với nền Windows. 

+ PDF (.pdf) Portable Documents Format: hoạt động kết hợp với phần mềm 

Acrobat của Adobe, cũng là dạng thức tập tin dùng để sản xuất trang web. 

+ Targe (.tga): dùng cho hệ thống Card Video. 

+ Tiff (.tif): một dạng thức rất phổ biến dùng trao đổi giữa các ứng dụng và nền 

máy tính. 

…….. 

Điều chúng ta cần tìm hiểu là hai dạng lưu ảnh chính: 

Ảnh dạng Bitmap: Photoshop tạo ra ảnh Bitmap hay còn gọi là ảnh mành (raster). 

Dạng ảnh này sử dụng một lưới các ô vuông nhỏ hay còn gọi là lưới điểm ảnh 

(Pixel – picture element - phần tử ảnh) để biểu diễn ảnh. Mỗi điểm ảnh (Pixel) 

được gán một vị trí và một giá trị màu. Ảnh bitmap phụ thuộc vào độ phân giải, 

một ảnh chứa một số lượng điểm ảnh nhất định để hiển thị dữ liệu hình ảnh. Kết 

quả là ảnh Bitmap có thể bị mất chi tiết và trở nên không đều nếu được nhìn ở độ 

phóng đại cao (điểm ảnh khi bị phóng to) trên màn hình hoặc in ảnh ở chế độ quá 

thấp. 

Ảnh Vector: Một số chương trình đồ họa tạo ra ảnh Vector như Corel Draw hay 

Adobe Illustrator gồm các đường thẳng và đường cong được xác định bằng các 

hàm toán học. Một điều đáng chú ý là đồ họa vector không phụ thuộc vào độ phân 

giải nên khi xuất ảnh ra màn hình hoặc thiết bị in đều có chất lượng tốt. Có thể coi 

đồ họa vector là lựa chọn tốt nhất cho việc in ấn các loại ảnh cần có chi tiết chính 

xác cao. 
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1.2 Độ phân giải và kích thước ảnh 

Để tạo được một bức ảnh có chất lượng cao điều quan trọng là phải nắm được cách 

thức đo và hiển thị dữ liệu điểm ảnh khi làm việc với ảnh Bitmap. 

Kích thước diểm ảnh: Số lượng điểm ảnh được phân bổ theo chiều dọc và chiều 

ngang. Kích cỡ hiển thị của ảnh trên màn hình được xác định bằng kích cỡ điểm 

ảnh của hình ảnh cộng với kích cỡ ảnh và xác lập màn hình. Kích cỡ tập tin của 

một hình ảnh tỷ lệ thuận với kích cỡ điểm ảnh. Có nghĩa là khi số điểm ảnh càng 

nhiều cộng với số lượng màu cho một điểm ảnh lớn thì kích thước tập tin càng lớn. 

Kích cỡ hiển thị trên màn hình: Độ lớn của hình ảnh trên màn hình phụ thuộc vào 

nhiều yếu tố như kích thước điểm ảnh của hình ảnh, kích cỡ màn hình và xác lập 

độ phân giải màn hình. 

Độ phân giải hình ảnh: Số lượng điểm ảnh được hiển thị trên một đơn vị chiều 

dài được in trong ảnh thường được đo theo điểm ảnh/inch. Ảnh có độ phân giải cao 

chứa nhiều điểm ảnh, do đó điểm ảnh nhỏ hơn so với hình ảnh được in cùng kích 

thước nhưng có độ phân giải thấp.  

Do sử dụng nhiều điểm ảnh để biểu thị từng đơn vị diện tích nên ảnh có độ phân 

giải cao thường tái tạo nhiều chi tiết hơn và chuyển tiếp màu tinh tế hơn so với ảnh 

có độ phân giải thấp khi in. Tuy nhiên khi tăng độ phân giải của ảnh được quét 

hoặc ảnh được tạo ra từ độ phân giải thấp thì chỉ trải rộng thông tin điểm ảnh gốc 

theo số lượng điểm ảnh lớn hơn chứ ít khi cải thiện được chất lượng ảnh. 

Muốn xác định độ phân giải ảnh để sử dụng cần tính đến môi trường phân phối 

điểm ảnh. Nếu tạo ảnh chỉ để hiển thị trực tuyến thì độ phân giải ảnh chỉ cần tương 

ứng với độ phân giải màn hình thông thường (72 hoặc 96 dpi). Nếu sử dụng độ 

phân giải quá thấp cho ảnh in sẽ gây ra hiện tượng điểm ảnh bị lóa, bản in có 

những điểm ảnh lớn và thô. Trường hợp sử dụng độ phân giải quá cao sẽ làm tăng 

kích thước tập tin, chậm quá trình in thậm chí thiết bị không có khả năng in. 

Độ phân giải màn hình : Số lượng các điểm ảnh hoặc các điểm hiển thị trên một 

đơn vị chiều dài trên màn hình thường được đo theo đơn vị điểm/inch. Độ phân 

giải màn hình phụ thuộc vào kích cỡ màn hình cộng với việc xác lập điểm ảnh. Độ 



 5 

phân giải thông thường của máy tính PC là khoảng 96dpi. Khi độ phân giải hình 

ảnh cao hơn độ phân giải màn hình, hình ảnh trên màn hình lớn hơn so với kích 

thước in được xác định. 

Kích thước tập tin: được đo theo kilobyte (KB), megabyte (MB), gigabyte (GB). 

Kích thước tập tin tỷ lệ với các kích thước điểm ảnh, các hình ảnh có nhiều điểm 

ảnh tạo ra nhiều chi tiết hơn ở kích cỡ in cho trước nhưng đòi hỏi không gian đĩa 

để lưu trữ và chậm khi hiệu chỉnh hay in. 

1.3 Các mô hình màu 

1.3.1 Mô hình màu RGB 

Dãy quang phổ nhìn thấy, được biểu thị bằng cách pha trộn ánh sáng của ba màu 

RGB: Red, Green, Blue theo tỷ lệ và cường độ khác nhau. Mỗi pixel được gán giá 

trị cường độ biến đổi từ 0 đến 255 với từng thành phần trong mỗi ảnh. Các ảnh 

màu trong chế độ RGB sử dụng ba màu (ba kênh) tái tạo 16,7 triệu màu lên màn 

hình.  

Chế độ màu RGB thường được màn hình máy tính sử dụng để hiển thị. 

1.3.2 Mô hình và chế độ màu CMYK 

CMYK: Cyan (xanh lơ chuẩn), Magenta (đỏ xen), Yellow (vàng), Black (đen). Mô 

hình CMYK được thiết kế dùng để in. Mỗi pixel trong chế độ CMYK được gán giá 

trị theo tỷ lệ phần trăm (có giá trị từ 0 đến 100) với màu nhạt được gán tỷ lệ màu 

thấp, màu tối tỷ lệ cao. 

Câu hỏi ôn tập 

Ø Cho biết một số cấu trúc ảnh hiện nay trong lĩnh vực xử lý ảnh? 

Ø Thế nào là độ phân giải ảnh? Độ phân giải màn hình? 
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1.4  Các thành phần màn hình của Photoshop 

1.4.1 Thanh menu 

 

Thanh tiêu đề Thanh Menu 

Các bảng 
chức năng 

Thanh tùy chọn 

Vùng thao tác 
với ảnh 

Hộp công 
cụ 

Bảng 
màu 

Vùng thao tác 
với ảnh 
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1.4.2 Hộp công cụ  

Toolbox - hộp nằm bên trái của vùng làm việc chứa các công cụ, bao gồm các 

công cụ vẽ và hiệu chỉnh, các hộp màu Foreground và Background, các công cụ 

xem ảnh. 

Nhấp chuột vào một công cụ bất kỳ để chọn công cụ đó. Mỗi biểu tượng công cụ 

đại diện cho một nhóm công cụ đang ẩn. Nếu muốn chọn một công cụ đang bị ẩn 

ta kích chuột phải, danh sách các công cụ ẩn sẽ hiện ra. Rê chuột đến công cụ cần 

chọn và bấm chuột. 

Khi chọn được công cụ cần dùng, ta phải quan tâm đến các thông số trên thanh tuỳ 

chọn liên quan đến công cụ đó. Từ đó thiết lập các giá trị cần thiết phù hợp với 

công việc. 

1.4.3 Thanh tùy chọn 

File Browser là một chế độ xem ảnh tiện dụng nhất mà Photoshop cung cấp cho 

chúng ta. Đây là một trong các tính năng của Photoshop mà bạn có thể sử dụng để 

tìm file ảnh mà bạn cần. 

Thao tác: 

Nhấp nút File Browser trên thanh tùy chọn. 

Trong hộp thoại File Browser tìm đường dẫn đến file mà bạn muốn mở. Khi bạn 

chọn folder, các thumbnail về nội dung folder xuất hiện ở ô bên phải của File 

Browser. 

Chọn file mà bạn muốn mở và mở nó bằng một trong các cách sau: 

Ø Nhấp đúp vào Thumbnail dành cho file 

Ø Chọn Thumbnail dành cho file và sau đó sử dụng thanh menu bên trong File 

Browser, chọn File\Open. 

Sau khi bạn đã chọn được file ảnh muốn xem thì đóng File Browser lại. 

1.4.4 Giới thiệu các bảng chức năng 

Các bảng chức năng nằm ở phần bên phải của màn hình Photoshop. Để xuất hiện 

các bảng chức năng này ta lấy nó từ menu Window của Photoshop. 

Bảng Info: 
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Bảng Info hiển thị các thông tin: 

Ø Giá trị màu tại điểm con trỏ đang di chuyển. 

Ø Tọa độ vị trí x, y của con trỏ trên ảnh. 

Ø Chiều rộng, chiều cao của các vùng chọn. 

Ngoài ra bảng này cũng đưa ra bốn mẫu màu được sử dụng cùng với công cụ Color 

Sampler. 

Bảng Navigator: 

Hiển thị một phiên bản nhỏ của toàn bộ hình ảnh nằm trong Canvas trong cửa sổ 

đang hoạt động. 

Thao tác: Rời con trỏ lên trên hình ảnh trong bảng Navigator và điều chỉnh theo 

hướng. 

Bảng Swatches: 

Chọn mầu có sẵn cho Background và Foreground. 

Chú ý: Khi làm việc với bảng này ta có thể phối thêm mầu mới bằng cách chọn 

New. Có thể bỏ màu chọn bằng cách chọn Delete. 

Ø Để thay màu khác thì chọn biểu tượng mũi tên và chọn Replace Swatches. 

Ø Để chèn thêm màu: Load Swatches. 

Ø Khôi phục bảng màu: Reset Swatches. 

Bảng Color: 

Dùng để chọn màu pha tuỳ ý cho Background và Foreground bằng cách kéo thanh 

trượt để chọn màu. 

Chú ý: Để chọn màu cho Background trước hết phải chọn màu cho Foreground sau 

đó nhấn phím X để đảo màu. 

Bảng Styles: 

Dùng để chọn màu tô cho vùng chọn với các mẫu màu có sẵn. 

Bảng Brushes: 

Dùng để điều chỉnh kiểu cọ vẽ (kích thước, kiểu tô) 

Bảng History: 
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Cho phép ghi lại tình trạng của đối tượng theo từng bước (trên hai mươi tình 

trạng). 

Bảng Paths: 

Chứa đựng các thông tin về đường dẫn 

Bảng chanels: 

Giúp chỉnh màu và làm việc với mặt nạ và kênh. Thực hiện các thao tác trên kênh, 

hiệu chỉnh ẩn hiện kênh. 
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CHƯƠNG 2 

CÔNG CỤ VÀ CÁC LỆNH HIỆU CHỈNH ẢNH CỦA PHOTOSHOP 

2.1 Hộp công cụ 

2.1.1 Nhóm công cụ Marquee (M) 

  Đây là bộ công cụ để tạo vùng chọn trong khi xử lý một bức ảnh. 

Công cụ Rectangular Marquee: Tạo vùng chọn là một hình chữ nhật tuỳ theo 

quy định của người làm ảnh.  

Công cụ Elliptical Marquee: Tạo vùng chọn theo hình elip tùy theo quy định của 

người làm ảnh.  

Công cụ Single Row Marquee: Tạo vùng chọn theo một hàng có độ cao 1pixel 

(như một đường kẻ ngang). 

Công cụ Single Column Marquee: Tạo vùng chọn theo một cột có độ rộng 1pixel 

(như một đường kẻ đứng). 

Lưu ý: Các chức năng trên thanh thuộc tính: 

Ø Feather: dùng để xác định độ chính xác của đường Marquee, giá trị feather 

càng nhỏ thì độ chính xác càng cao, ngược lại giá trị feather càng lớn thì độ 

chính xác càng thấp 

Ø New selection: tạo vùng chọn mới. 

Ø Add to selection: mở rộng thêm vùng chọn. 

Ø Subtract from selection: trừ bớt đi vùng chọn. 

Ø Intersect with selection: lấy phần giao của hai vùng chọn. 

Ø Anti-aliased: bật tắt chế độ răng cưa của Eliptical Marquee. 

Ø Style: có ba chế độ 

Normal: mặc định kích thước marquee bằng cách kéo chuột. 

Fixel Espect Ratio: tạo vùng chọn có tỷ lệ chiều cao và rộng được nhập 

trong mục Height và Width. 

Pixel Size: tạo vùng chọn là một hình vuông hay hình tròn với kích thước cố 

định được cho bởi Width và Height. 
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Thao tác chọn: 

Ø Nhấp chuột vào công cụ Marquee trên toolbox và đặt các tuỳ chọn. 

Ø Di chuyển công cụ lên bức ảnh và rê chéo từ góc bên trái đến góc dưới phải 

của đối tượng cần chọn. 

Ø Đến vị trí thích hợp thì nhả nút chuột. 

Ø Nếu nhấn giữ phím Shift trong khi rê sẽ tạo được mục chọn theo hình vuông 

hay hình tròn. 

Lưu ý: có thể rê chọn từ tâm đối tượng bằng cách: Chọn công cụ Marquee nhấn 

Alt, di chuyển công cụ lên bức ảnh vẫn nhấn Alt, rê từ tâm đối tượng ra ngoài biên, 

xong nhả phím chuột rồi nhả phím Alt. 

2.1.2 Công cụ Move (V) 

  Dùng để dịch chuyển vùng chọn, lớp và đường gióng. 

Thao tác: kích chuột vào công cụ Move trên hộp công cụ. Sau đó chọn đối tượng 

cần di chuyển trên vùng nhìn của Photoshop đồng thời rê chuột trên đối tượng đó. 

2.1.3 Nhóm công cụ Lasso (L) 

Công cụ Lasso: sử dụng Lasso có thể tạo các vùng chọn có hình dáng khác 

thường đòi hỏi các đường thẳng và các đường vẽ tự do. Khi dùng công cụ cần phải 

có kỹ năng khéo léo khi rê chuột. 

Thao tác chọn:  

Ø Chọn công cụ Lasso từ Toolbox hoặc gõ phím L 

Ø Nhấp và rê công cụ Lasso xung quanh mảng ảnh muốn chọn, bạn sẽ thấy 

một đường nhấp nháy như chọn bằng Marquee (nhớ là không thả chuột). 

Ø Khi sắp sửa hoàn tất lựa chọn, bạn có thể nhả chuột. Lúc đó hai đầu của 

đường nhấp nháy tự động kết nối lại tạo mục chọn kín. 

Công cụ Polygon Lasso: Tương tự như công cụ Lasso nhưng công cụ này 

có khả năng khác biệt, đó là tạo ra các lựa chọn hình học đặc biệt (như hình đa 



 12 

giác). Chỉ cần nhấp bằng Polygon Lasso để đặt những điểm cần thiết, Photoshop sẽ 

tạo một marquee đường thẳng vào giữa các điểm đó. Có thể đặt nhiều điểm gần kề 

hoặc xa nhau theo ý muốn. 

Thao tác chọn:  

Ø Nhấp giữ công cụ Lasso cho đến khi xuất hiện bảng nhóm công cụ này. 

Rê chuột đến công cụ Polygon Lasso. 

Ø Nhấp một điểm trên ảnh và di chuyển chuột. Đường thẳng sẽ đi theo 

Polygon Lasso mỗi khi di chuyển Polygon Lasso đó. 

Ø Nhấp chuột một lần nữa để vẽ đường đầu tiên rồi thiết đặt điểm khác và 

tiếp tục chọn. 

Ø Để kết thúc mục chọn bạn hãy nhấp đôi chuột. 

Công cụ Magnetic Lasso (Lasso từ tính): Dùng công cụ này có thể 

chọn tự do, các vùng chọn có các cạnh với độ tương phản cao. Có nghĩa là khi cần 

chọn có những màu tương đối khác biệt nhau ở đường biên vùng chọn thì có thể 

sử dụng công cụ này. Khi vẽ, đường biên tự động nối các cạnh mà bạn đang dò 

lại, ngoài ra có thể điều khiển hướng đi của công cụ bằng cách nhấp chuột để đặt 

các điểm chốt riêng trong đường biên mục chọn. 

Thao tác chọn: 

Ø Chọn công cụ Magnetic Lasso và thiết đặt các tuỳ chọn cho phù hợp với 

vùng cần chọn. 

Ø Nhắp chuột ở một ví trí trên đường biên hình muốn chọn để đặt điểm 

chốt đầu tiên. 

Ø Rê chuột trên đường biên, công cụ sẽ tự động đặt vào các điểm chốt. 

Ø Khi đến điểm bắt đầu, nhấp đôi chuột để kết thúc mục chọn. 

Lưu ý: Khi rê chọn ở các vùng có độ tương phản thấp, nếu công cụ không theo 

sát cạnh, có thể đặt điểm chốt riêng ở đường biên bằng cách nhấp nút chuột. Để 

xóa các điểm định hướng trong khi tạo vùng chọn nhấn Delete. Để huỷ bỏ thao 
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tác đang thực hiện nhấn Esc. Để tạo vùng chọn tự do nhấn giữ Alt trong khi 

kích chuột. 

2.1.4 Công cụ Magic Wand (W) 

Công cụ Magic Wand Chọn công cụ Magic Wand trên hộp công cụ. 

Ø Nhấp công cụ Magic Wand vào bất kỳ nơi nào trong hình muốn chọn. 

Nếu hình muốn chọn chưa được chọn hết, hãy nhấn giữ phím Shift và nhấp vào 

các vùng muốn chọn thêm. 

2.1.5 Công cụ Crop (C) 

Đây là công cụ cắt xén hình ảnh trong Photoshop. Nó có tác dụng xén ảnh 

với kích cỡ đưa vào từ bàn phím hoặc cắt xén tự do theo tính tương đối của 

người sử dụng. 

Xén tự do: Lựa chọn công cụ Crop, sau đó lựa chọn vùng cần cắt xén. Khi đã có 

vùng chọn, nhấp đúp chuột vào trong vùng chọn để xén hình hoặc nhấn Enter 

để thực hiện xén ảnh. 

Xén ảnh có kích thước: Nhập giá trị chiều rộng và chiều cao của vùng cắt xén 

trong mục Width và Height. Sau đó thực hiện các bước cắt xén như với cắt xén 

tự do ở trên. 

Mục Resolution xác định độ phân giải hình ảnh được đo bằng Pixel/inch hay 

Pixel/cm 

Mục Clear dùng để xóa giá trị kích thước xén 

Mục Font Image dùng để nhập kích thước xén cho ảnh. 

2.1.6 Nhóm công cụ tô vẽ (S) 

 Công cụ Clone Stamp: có tác dụng sao chép hình ảnh và dán nó ở nơi 

khác. Nó trích mẫu từ một điểm trong hình ảnh, nhân bản mẫu được trích. Chọn 

điểm để nhân bản bằng cách nhấn phím Alt đồng thời nhấp chuột lên vùng 

muốn nhân bản, thả phím Alt và sao chép bằng cách dời chuột đến vị trí mới rồi 

nhấn và kéo chuột. Vì Clone Stamp hoạt động giống như một cọ vẽ nên có thể 
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áp dụng mọi chế độ tô vẽ. Kích cỡ và hình dạng của bản sao cũng chính là kích 

cỡ và hình dạng của cọ vẽ bạn đã chọn. Bạn cũng có thể áp dụng những xác lập 

về độ mờ đục cho bất kỳ cọ vẽ nào. 

Công cụ Pattern Stamp: dùng để tô những mẫu có sẵn 

2.1.7 Nhóm công cụ Patch (J) 

 Công cụ Patch Tool: cũng tương tự như công cụ Clone Stamp, cho 

phép thực hiện việc sao chép và khả năng phối trộn giữa các pixel từ một vùng 

ảnh này sang một vùng ảnh khác. 

2.1.8 Nhóm công cụ Brush (B) 

Công cụ Brush: là công cụ thường được dùng trong các công cụ tô vẽ của 

Photoshop. Dùng tạo nét vẽ như cọ mờ và gọi là hiệu ứng vẽ bằng cọ, các vệt 

cọ được áp dụng đều đặn. 

Công cụ Pencil: Rất giống công cụ Brush về phương thức hoạt động chỉ 

khác ở chỗ đường vẽ sắc nét hơn. 

2.1.9 Nhóm công cụ hiệu chỉnh dữ liệu Blur (R) 

Công cụ Blur: dùng để tạo hiệu ứng nhòe không rõ nét cho hình ảnh. 

Công cụ này thường được sử dụng để làm giảm bớt các tác động của ảnh phông 

(nền) gây ra cho toàn hình ảnh bằng cách làm nhòe nó, qua đó làm hình ảnh 

Foreground nổi bật hơn và sắc nét hơn bình thường. Khi làm nhòe, phải phủ kín 

toàn bộ vùng định làm nhòe, có thể thay đổi kích cỡ của công cụ. 

Công cụ Smudge: Đây là một trong số những công cụ có tính trực giác 

nhất trong hộp công cụ. Biểu tượng đại diện cho công cụ này là hình bàn tay 

với ngón trỏ chỉ xuống, trên thực tế công cụ này cho phép đẩy màu vẽ ra xung 

quanh (làm nhòe đường biên), trơn nhẵn các đường nối trong hình ảnh. Công cụ 

này có thể pha trộn và làm mờ các pixel để tạo đường viền mờ và mịn hơn. 
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Công cụ Sharpen: Là công cụ đối nghịch với công cụ Blur, Sharpen lại 

làm sắc nét chúng, bằng cách gia tăng các thành phần sắc độ, cường độ và độ 

tương phản của chúng. Công cụ này tác động lên nơi chuyển tiếp giữa các màu, 

tạo rìa theo các màu khác nhau, nhằm tăng độ tương phản qua đó tạo hiệu ứng 

sắc nét cho hình ảnh. 

2.1.10 Nhóm công cụ Eraser Tool (E) 

 Công cụ Eraser: xóa và phục hồi ảnh lưu trước đó. Có thể thiết lập 

công cụ Eraser để bôi xóa dưới dạng công cụ Brush, Pencil hoặc Block. Con 

trượt Opacity quyết định khoảng bị xóa. Đặc tính này hữu ích đối với việc hòa 

trộn các phần của hình ảnh, hoặc tạo một hiệu ứng màu nước đẹp mắt. 

2.1.11 Nhóm công cụ tạo hiệu ứng hòa trộn (G) 

Công cụ Gradient: cung cấp phương pháp tạo các dạng tô đầy chuyển 

tiếp từ màu này sang màu khác. Có rất nhiều kiểu tô, ngoài ra cũng có tạo 

những kiểu tô riêng. Nhấp và giữ chuột trên công cụ Gradient để chọn. Thanh 

thuộc tính cho phép chọn lựa kiểu tô. Mục Mode chứa các chế độ hòa trộn và 

độ mờ đục. Kiểu tô Gradient có thể được chuyển đổi giữa trạng thái có màu và 

trong suốt, giữa màu Foreground và Background. Kéo chuột một khoảng càng 

xa, sự chuyển tiếp diễn ra càng chậm và tinh tế. Khoảng cách kéo càng ngắn, sự 

chuyển tiếp diễn ra càng nhanh. 

Công cụ Paint Bucket: Dùng tô đầy những vùng có màu tương tự (màu 

tô được chọn trên thanh thuộc tính). Khi muốn đổi màu cho một vùng chọn lớn 

có cùng tông màu, thì đây chính là công cụ bạn cần. Dĩ nhiên có thể dùng công 

cụ Brush nhưng sẽ dễ bị vẽ nhầm lên hình ảnh. Sau khi đã chọn được màu như 

ý, bạn nhắp đúp chuột vào công cụ Paint Bucket trong hộp công cụ, sau đó kích 

chuột vào đối tượng cần tô. 

2.1.12 Nhóm công cụ tạo hình Pen (P) 
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Pen tool: dùng tạo ra các điểm neo hay các đường dẫn bằng cách nhấn 

chuột, kết thúc công việc bằng cách nhấp lại công cụ Pen hoặc chọn một công 

cụ bất kỳ trên Tool Box. 

Lưu ý:  

Các điểm đầu và cuối gọi là các điểm neo, đường thẳng nối các điểm neo gọi là 

các đường dẫn.  

Đường dẫn thì có đường dẫn kín và hở, đường dẫn không kín là đường dẫn có 

hai điểm đầu và cuối không trùng nhau và ngược lại. 

Tạo đường viền uốn lượn (đường dẫn cong) bằng cách nhấn và giữ chuột trái 

trong khi rê tạo đường dẫn. Đường cong được tạo ra có thể kín hay hở. 

Có thể chọn một hoặc nhiều điểm neo trên đường dẫn bằng cách nhấp chuột và 

rê bao quanh điểm neo cần chọn. 

2.1.13 Công cụ Type (T) 

Công cụ Type: tạo ký tự trên hình ảnh. 

Các tuỳ chọn: 

+ Horizontal Type Tool: gõ chữ theo chiều ngang. 

+ Vertical Type Tool: gõ chữ theo chiều dọc. 

+ Horizontal Type Mask Tool: tạo vùng chọn có dạng văn bản theo chiều 

ngang. 

+ Vertical Type Mask Tool: tạo vùng chọn có dạng văn bản theo chiều dọc. 

Thao tác tạo chữ: 

Ø Nhấp công cụ Type trên hộp công cụ. 

Ø Nhấp vào ảnh nơi đặt chữ. 

Ø Chọn Font chữ, kích cỡ, khoảng cách dòng. 

Ø Nhắp chọn màu. Nhắp OK 

Ø Căn thẳng hàng bằng cách nhấp Left, Center hoặc Right Justified. 

Ø Nhập văn bản vào ô trống ở dưới hộp thoại. Nhấp OK. 
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2.2 Các lệnh hiệu chỉnh hình ảnh 

2.2.1 Nhóm lệnh trên Image/Adjustment 

2.2.1.1 Điều chỉnh góc độ ảnh: 

Nếu muốn quan sát ảnh ở một góc độ bất kỳ ta thực hiện thao tác này để thay 

đổi góc độ của bức ảnh. 

- Chọn toàn bộ bức ảnh bằng cách nhấn tổ hợp phím Ctrl + A. 

- Từ menu chọn Edit\Transform hoặc nhấn tổ hợp phím Ctrl + T. 

Xuất hiện các điểm neo ở bốn góc của bức ảnh. 

- Đặt chuột tại mỗi góc cần quay và giữ chuột. 

- Kéo thả chuột khi cảm thấy góc độ của bức ảnh là phù hợp. 

- Nhấn Enter để xác nhận thao tác (nếu muốn huỷ thao tác nhấn ESC). 

2.2.1.2 Chỉnh sửa độ phân giải và kích cỡ ảnh: 

Trong thao tác này bạn sẽ sử dụng công cụ Crop (C) để xén và định tỷ lệ kích 

thước cho một bức ảnh. 

- Trên hộp công cụ chọn công cụ Crop hoặc nhấn phím C từ bàn phím. 

Trên thanh tuỳ chọn nhập giá trị cho các ô sau:  

+ Width: chiều rộng của ảnh. 

+ Height: chiều cao của ảnh. 

+ Resolution: nhập độ phân giải cho bức ảnh. 

Đơn vị có thể là cm hoặc inch. 

- Kéo rê chuột tạo một vùng hình chữ nhật trên bức ảnh. Khi bạn kéo rê chuột 

thì tỷ lệ kích thước bạn nhập vẫn luôn được duy trì. 

- Kéo thả chuột một tấm xén che phủ phần ngoài, phần bên trong cần lấy sẽ 

được hiển thị trên khung nhìn. Quan sát bức ảnh để bạn kéo thả chuột cho phù 

hợp với góc độ cần lấy. 

- Nhấn Enter để xác nhận việc cắt xén ảnh. 

2.2.1.3 Chỉnh sáng tối/tương phản: 
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Trong khi chỉnh sửa ảnh bạn có thể chỉnh độ sáng tối của ảnh bằng các công cụ 

sau: 

• Cửa sổ Levels dùng điều chỉnh mọi tông màu trong ảnh cho cả ảnh màu và ảnh 

đen trắng. Ngoài ra có thể biết các vùng sáng nhất và tối nhất trong ảnh. 

Từ Menu chọn Image\Adjustments\Levels hoặc nhấn tổ phím Ctrl + L→xuất hiện 

cửa sổ: 

 
- Cách sử dụng: Kéo các con trượt để điều chỉnh giá trị sáng tối của màu sắc. 

*.Cửa sổ Curves: tác dụng cũng gần như cửa sổ Levels nhưng không tạo độ tương 

phản mạnh. 

Từ menu chọn Image/Adjustments/Curves hoặc từ bàn phím nhấn Ctrl +  

M →xuất hiện cửa sổ: 

 
- Cách sử dụng: nhấp và kéo rê đường biểu diễn để chỉnh sửa, thay đổi độ sáng 

tối. 

2.2.1.4 Điều chỉnh cân bằng về màu sắc: 
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- Thao tác thực hiện: từ menu chọn Image\Adjustments\Color Balance (Hoặc gõ 

Ctrl + B) → xuất hiện cửa sổ: 

 
 

- Cách sử dụng: 

+ Tuỳ chọn Preserve Luminosity: duy trì độ sáng tối. 

+ Các con trượt Cyan – Red, Magenta – Green, Yellow – Blue dùng cân chỉnh lại 

màu sắc, khi kéo con trượt về một phía thì màu ở phía đó được tăng lên và màu ở 

phía đối lập sẽ giảm đi. 

+Các tuỳ chọn trong Tone Balance: lựa chọn tông màu để điều chỉnh. 

2.2.1.5 Lệnh Brightness/Contrast: 

Từ menu chọn Image\Adjust\Brightness – Contrast hoặc từ bàn phím nhấn Alt + I 

+ A + C → xuất hiện cửa sổ: 

 
- Công dụng: 

+ Điều chỉnh độ sáng tối của hình ảnh bằng thanh trượt Brightness – Contrast. 

2.2.1.6 Lệnh tinh chỉnh các thành phần màu: 

Từ menu chọn Image\Adjustments\Selective Color hoặc nhấn tổ hợp phím Alt + I 

+ A + S → Xuất hiện cửa sổ: 
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- Công dụng: tinh chỉnh các thành phần màu hàm chứa trong một màu cơ bản. 

- Cách sử dụng: 

+ Chọn màu cần điều chỉnh trong hộp Color. 

+ Kéo các con trượt Cyan, Magenta, Yellow, Black để tăng (giảm) giá trị các màu 

này đang hàm chứa. 

6.2.6 Lenh Match Color: 

Tu menu Image chon Image\Adjustment\Match color hoac an to hop phim Alt + I 

+ A + M. xuat hien hop thoai: 

2.2.1.7 Lệnh Duplicate: 

- Thao tác: từ menu chọn Image\Duplicate 

- Công dụng: tạo bản sao của file ảnh hiện hành, nhưng chưa được lưu. 

2.2.1.8 Lệnh Image Size: 

- Thao tác: từ menu chọn Image\Image Size 

- Công dụng: Kiểm tra và điều chỉnh kích thước, độ phân giải của file ảnh. Có các 

thông số sau: 
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+ Pixel Dimenson: kích thước của file ảnh tính bằng đơn vị Pixel và dung lượng 

chiếm dụng bộ nhớ của file ảnh. 

+ Mục Document Size: kích thước thực và độ phân giải của file ảnh. 

+ Tuỳ chọn Constrain Proportion: duy trì tỷ lệ giữa chiều ngang và chiều dọc của 

file ảnh khi thay đổi giá trị của một chiều. 

+ Tùy chọn Resample Image: duy trì mối tương quan giữa kích thước và độ phân 

giải. 

2.2.1.9 Lệnh Canvas Size: 

- Thao tác: từ menu chọn Image\ Canvas Size: 

- Công dụng: thay đổi kích thước trang vẽ của file ảnh mà không thay đổi kích 

thước của hình ảnh. 

- Các mục trong bảng thoại của lệnh Canvas Size: 

 
+ Nhập kích thước mới cho file ảnh trong mục New Size 

+ Chọn hướng thay đổi và điểm mốc thay đổi kích thước file ảnh ở mục Anchor. 

2.2.1.10 Lệnh Rotate Canvas: 

- Thao tác: Từ menu chọn Image\ Rotate Canvas  

- Công dụng: xoay hoặc lật toàn bộ hình ảnh. 

2.2.2 Nhóm lệnh trên Select 

- Edit\Free Transform (Ctrl + T) 

 Scale: co dãn tỷ lệ của đối tượng. 

 Rotate: Quay đối tượng 
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 Skew: kéo dãn đối tượng 

 Distort: làm biến dạng 

 Perspective: tạo bối cảnh 

 Rotate 1800CW: quay 1800 

 Rotate 900CW: quay 900 theo chiều kim đồng hồ 

 Rotate 900CCW: quay 900 ngược chiều kim đồng hồ 

• Để mở rộng vùng chọn: trên thanh menu\Select\Modify\Expand. 

• Ngoài ra có thể sử dụng chức năng Similar: tạo vùng chọn ở những nơi cách 

nhau trên ảnh. 

+ Grow: thêm các điểm ảnh kế cận. 

• Để thu nhỏ vùng chọn: từ thanh menu chọn Modify\Contract 

+ Border: tạo vùng chọn đồng dạng với một vùng chọn đã có 

+ Smooth: bo tròn vùng chọn hoặc có thể sử dụng Feather bằng cách nhấn tổ 

hợp phím Ctrl + Alt + D 

2.2.3 Layer và các thao tác trên Layer 

2.2.3.1 Các lớp ảnh trong Photoshop 

Trong hệ thống chuẩn (dùng để xử lý) Photoshop lưu file ảnh dưới dạng file.psd. 

Các file này có dung lượng khá lớn tùy vào chất lượng ảnh in ra hoặc để lưu trữ tất 

nhiên là các file.psd này lưu ảnh dưới cấu trúc lớp hay còn gọi là layer. Trong cấu 

trúc file ảnh này, ảnh được phân ra làm các lớp khác nhau. Mỗi lớp là một hình ảnh 

riêng, không bị dính vào các lớp ảnh khác trong cùng một file.psd. Một tập hợp 

nhiều ảnh nhỏ tạo thành một file ảnh hoàn chỉnh theo ý muốn của người sử dụng 

hoặc chỉnh sửa. Chính vì có các lớp riêng biệt này mà Photoshop cho phép người 

sử dụng có khả năng chỉnh sửa rất nhiều theo ý muốn của mình để có được bức ảnh 

đưa ra theo mong muốn. 

Các lớp được Photoshop lưu thành các ảnh nhỏ khác nhau. Mỗi thao tác chỉnh sửa 

trong Photoshop chỉ được thực hiện trên một lớp hiện hành do người sử dụng chọn 

ra theo yêu cầu. 

2.2.3.2 Thứ tự các lớp trong Photoshop 
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Thứ tự các lớp trong Photoshop được sắp xếp một cách có trật tự nhưng tuân theo 

ý muốn của người dùng. Các lớp nằm ở trên sẽ đè lên các lớp nằm ở dưới. Trong 

chế độ hiển thị ảnh 100% thì những phần trùng nhau hay giao nhau của hai lớp thì 

hiện tượng chỉ nhìn thấy phần hiển thị của lớp trên còn lớp dưới sẽ bị che khuất. 

Tuy nhiên trong chế độ trong suốt của ảnh thì các phần của các lớp sẽ được nhìn 

thấy tùy vào độ trong suốt của người sửa chữa ảnh. 

2.2.3.3 Các chức năng của lớp trong Photoshop 

Lớp (Layer) trong Photoshop: Một lớp trong Photoshop là một phần tử của ảnh 

lớn. Nhiều lớp trong một ảnh lớn tạo thành một ảnh hoàn chỉnh. Các chỉnh sửa chỉ 

có tác dụng trên lớp đang được chọn hay lớp hiện hành. 

2.2.3.4 Tạo một lớp mới 

`` 

 

 

 

 

 

Trong bảng Layer ta có thể tạo một lớp mới khi nhấn vào biểu tượng Creat New 

Layer hoặc chọn menu Layer\New\New Layer hoặc nhấn Ctrl + Shift + N. Khi đó 

ta có thể thực hiện chỉnh sửa hoặc thao tác với ảnh trên lớp mới. Lớp mới này có 

tên ngầm định là layer x. Trong đó x là số của lớp khi được sinh ra. Tuy nhiên có 

thể đổi tên lớp nếu muốn bằng cách nhấp đúp chuột vào lớp muốn đổi tên sau đó 

nhập vào tên mới muốn đặt cho lớp. 

2.2.3.5 Đổi tên và sao chép một lớp 

Để đổi tên một lớp bạn chỉ nhấp đúp chuột vào lớp muốn đổi tên và nhập tên mới 

cho lớp. 

Sao chép một lớp: để tạo ra một lớp giống hệt lớp đang chọn ta thực hiện thao tác 

nhân đôi lớp như sau: chọn lớp cần sao chép trong bảng layer. Sau đó nhấn tổ hợp 

phím Ctrl + J. 

 

Độ hiển 
thị của 

lớp 

Creat New Layer 

Ô 
xích 

 
Ẩn/Hiện 

lớp Một lớp (Layer) 
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2.2.3.6 Sắp xếp lại các lớp 

Thứ tự các lớp trong bảng layer được sắp xếp theo thứ tự của người sử dụng. Các 

lớp nằm trên thì là các lớp nằm ngoài nhất của ảnh và ngược lại với các lớp nằm 

dưới. Khi muốn di chuyển vị trí của một lớp, ta thực hiện chọn lớp đó sau đó có 

thể dùng chuột kéo lớp tới vị trí cần để hoặc dùng tổ hợp phím Ctrl + [ để đưa lớp 

lên phía trên hoặc Ctrl + ] để đưa lớp xuống phía dưới. 

2.2.3.7 Thay đổi độ mờ đục và chế độ của một lớp 

Trong bảng Layer có một ô tên là Opacity. Ô này có tác dụng chỉnh độ hiển thị của 

ảnh với mức từ 0 đến 100. Có nghĩa là khi ở mức 100% thì ảnh hiển thị hoàn toàn 

còn ở các mức còn lại thì ảnh ở chế độ trong suốt tùy theo mức Opacity được đặt. 

Trong trường hợp có một lớp ta không muốn xóa đi mà không muốn hiển thị lớp 

đó lên trên vùng nhìn khi làm việc ta có thể ẩn lớp đó đi bằng cách tắt con mắt 

trong ô hiển thị lớp. Qui định như sau: có con mắt có nghĩa là hiển thị ảnh và 

ngược lại không có con mắt thì ảnh sẽ không hiển thị. 

2.2.3.8 Liên kết các lớp 

Khi đã chỉnh sửa xong các lớp, nếu muốn dán chúng lại thành một lớp duy nhất 

cho dễ sử dụng ta thực hiện như sau: Chọn một lớp bất kỳ trong số lớp cần dán lại 

với nhau, xích các lớp cần dán lớp còn lại với các lớp đã chọn, nhấn tổ hợp phím 

Ctrl + E hoặc trên menu chọn Layer\Merge linked để thực hiện dán các lớp đó lại 

thành một lớp duy nhất. 

Để thực hiện dán tất cả các lớp trong bảng Layer lại thành một lớp duy nhất ta 

nhấn Ctrl + Shift + E hoặc vào menu Layer\Merge Visible. 

Chú ý: Không thể dán lớp chữ(Text) với lớp ảnh (Image), muốn dán hai lớp khác 

kiểu thì phải chuyển lớp chữ thành lớp ảnh rồi mới dán vào nhau được. 

2.2.3.9 Áp dụng một kiểu lớp 

Bạn có thể cải tiến một lớp bằng cách thêm một bóng đổ, điểm sáng, góc xiên, hình 

nổi hoặc các hiệu ứng đặc biệt khác từ một tập hợp các kiểu lớp tự động hóa và 

được hiệu chỉnh. Các kiểu này dễ áp dụng và liên kết trực tiếp mà bạn chỉ định. 
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Như các lớp, các kiểu lớp có thể bị ẩn bằng cách nhấp chuột vào các biểu tượng 

con mắt trong bảng Layer. Các kiểu này có thể được loại bỏ bất kỳ lúc nào. Bạn có 

thể áp dụng một bản sao của một kiểu lớp vào một lớp khác bằng cách rê hiệu ứng 

của nó vào một lớp đích. 

Bước đầu bạn phải chọn lớp cần định kiểu trên bảng Layer. Trên bảng Layer chọn 

mục Layer Styles xuất hiện hộp thoại chứa thông số của các hiệu ứng (kiểu). Bạn 

có thể chọn một hoặc nhiều hiệu ứng bất kỳ để áp cho lớp này đồng thời điều chỉnh 

các giá trị cho phù hợp. Nhấn OK để xác lập kiểu vừa thiết lập. 
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2.2.4 Các lệnh trong mục Filter 

2.2.4.1 Lệnh Extract: 

- Thao tác: từ menu chọn Filter\Extract hoặc từ gõ Ctrl + Alt + X 

- Công dụng: Trích xuất những hình ảnh phức tạp có biên không rõ ràng bị xen kẽ 

với nền. 

2.2.4.2 Lệnh Liquify: 

- Thao tác: từ menu chọn Filter\Liquify hoặc gõ Ctrl + Shift + X 

- Công dụng: làm biến dạng hình ảnh tuỳ theo tính năng từng công cụ của bảng 

- Tính năng của các công cụ: 

+ Warp (W): Làm cong hình ảnh. 

+ 2 công cụ Twirl (R, L): xoắn hình ảnh thuận và ngược chiều kim đồng hồ. 

+ Pucker (P): làm dúm hình ảnh. 

+ Bloat (B): làm dãn nở hình ảnh. 

+ Shift Pixel (S): dời chuyển hình ảnh. 

+ Reflection (M): phản hồi hình ảnh. 

+ Reconstruct (E): khôi phục lại hình ảnh ban đầu. 

+ Freeze (F): tạo vùng bảo vệ hình ảnh khỏi sự biến dạng. 

+ Thaw (T): xoá bỏ vùng bảo vệ. 

2.2.4.3 Cách sử dụng một số bộ lọc cơ bản – Filter 

 Tác dụng: bộ lọc được dùng để tạo  ra những hiệu ứng khác nhau cho hình ảnh. 

Hình ảnh đi qua bộ lọc sẽ bị biến đổi tuỳ theo tính chất của từng bộ lọc. Do có rất 

nhiều bộ lọc nên ở đây chỉ giới thiệu những bộ lọc cần thiết thường sử dụng. Còn 

lại, để tìm hiểu các bộ lọc khác ta cần phải dùng thử chúng để tìm ra những bộ lọc 

có ích cho công việc cụ thể của từng người. 

Các bộ lọc thường dùng: 

* Bộ lọc Artistic (hiệu quả nghệ thuật):  

- Dry more tạo ra hiệu ứng giống như tranh vẽ sơn dầu với những mảng màu không 

được vờn tỉa. 

* Bộ lọc Blur (làm mờ hình ảnh): 
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- Blur More: làm giảm độ sắc nét của hình ảnh. Thường được sử dụng để làm mờ 

những nét gai của hình ảnh, đặc biệt là những hình ảnh được scan từ bản gốc được 

in trên chất liệu giấy không mịn. 

- Monitor Blur: tạo hiệu ứng chuyển động thẳng cho hình ảnh, hiệu quả này sẽ 

tương tự hiệu quả của kĩ thuật lia máy trong nhiếp ảnh. 

- Radial Blur: tạo hiệu ứng chuyển động xoay (với tuỳ chọn Spin) và chuyển động 

hướng tâm (tuỳ chọn Zoom). 

* Bộ lọc Brush Strokes (hiệu quả của nét vẽ): 

- Crosshatch: tạo ra hình ảnh giống như được vẽ bằng bút chì với những nét vẽ đan 

chéo nhau. 

* Bộ lọc Distort (bóp méo hình ảnh): 

- Ocean Ripple: bóp méo hình ảnh dưới dạng bọt biển. 

- Ripple: bóp méo hình ảnh dưới dạng sóng nước. 

- Wave: bóp méo hình ảnh dưới dạng sóng. 

- Zigzag: bóp méo hình ảnh theo hình ngoằn ngoèo đồng tâm. 

* Bộ lọc Noise: 

- Add Noise: tăng độ nhiễu của hình ảnh bằng các hạt màu lấm tấm. 

* Bộ lọc Render:  

- 3D Transform: diễn tả hình ảnh theo không gian ba chiều dựa trên 3 khối cơ bản là 

lập phương, trụ, cầu. 

- Clouds: hoà trộn một cách ngẫu nhiên màu tiền cảnh và màu hậu cảnh, thường 

được ứng dụng để tạo ra mây trời. 

- Len Flare: hiệu quả loé sáng, giống như chụp ảnh ngược sáng. 

- Lighting Effect: hiệu ứng ánh sáng. 

* Bộ lọc Sharpen (tăng độ sắc nét của hình ảnh): 

- Unsharp Mask: làm sắc nét các đường biên trong ảnh, sửa lại những chỗ mờ nhoè. 

* Bộ lọc Stylize (cách điệu hình ảnh): 

- Emboss: tạo hiệu ứng dập nổi hình ảnh. 

- Trace Contour: tạo nét viền cho đường biên của sự chênh lệch sắc độ màu. 
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* Bộ lọc Texture (tạo kết cấu bề mặt cho hình ảnh): 

- Mosaic Tile: tạo một bề mặt giống như được khảm một lớp ngói. 

- Texturizer: tạo cho bề mặt hình ảnh một kết cấu của các chất liệu: vải bạt, sa 

thạch… 

* Chú ý:  

- Hầu hết các bộ lọc không áp dụng với ảnh Bitmap, ảnh Indexed Color, ảnh có 

kênh 16 bit. 

- Một số bộ lọc chỉ áp dụng cho ảnh RGB. 

- Muốn áp dụng lại bộ lọc được sử dụng gần nhất, ta vào menu Filter, bộ lọc được 

sử dụng gần nhất sẽ nằm trên đỉnh của menu hoặc gõ phím Ctrl + F. 

2.2.5 Các lệnh trong Blending Option 

Trong chuyên mục này ta sử dụng các layer style để tạo hiệu ứng cho các lớp. Các 

Layer Style được sử dụng để nâng cao hiệu quả thẩm mỹ cho các lớp ảnh (kể cả 

lớp chữ). Các Layer Style liên kết trực tiếp với lớp được áp dụng. 

Có thể mở bảng thoại Layer Style bằng các cách sau: 

- Vào menu Layer\Layer Style rồi chọn hiệu ứng cần áp dụng. 

- Kích đúp vào tên lớp cần áp dụng hiệu ứng trong bảng layer. 

- Kích vào nút Layer Style dưới đáy bảng Layer và chọn hiệu ứng cần sử dụng. 
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Bảng thoại Layer Style 

Phần rìa trái của bảng là danh mục các hiệu ứng. 

Phần ở giữa là các tuỳ chọn của hiệu ứng đang sử dụng. 

Layer Style gồm có các hiệu ứng sau: 

+ Drop Shadow: tạo bóng đổ bên dưới phần ảnh của lớp. 

+ Inner Shadow: tạo bóng đổ vào bên trong phần ảnh của lớp. 

+ Outer Glow: tạo bóng quầng (toả sáng) ra bên ngoài phần ảnh của lớp. 

+ Inner Glow: tạo bóng quầng (toả sáng) vào bên trong phần ảnh của lớp. 

+ Bevel and Emboss: hiệu ứng vát cạnh (chạm khắc và rập nổi). 

+ Satin: tạo bóng phía bên trong phần ảnh của lớp. 

+ Color Gradient, Pattern Overlay: che phủ (tô) cho phần ảnh của layer bằng một 

màu phẳng, màu chuyển (Gradient) hoặc bằng mẫu Pattern. 

+ Stroke: Tạo đường viền bao quanh phần ảnh của lớp với các màu đơn, màu 

Gradient, Pattern. 

* Tuỳ chọn của các Layer Style: 

+ Distance: Khoảng cách giữa lớp ảnh và bóng đổ. 

+ Spead (hoặc Choke): độ sắc nét của bóng. 
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+ Size: độ lớn của bóng. 

+ Contour: kích thước đường viền của bóng. 

+ Noise: độ nhiễu. 

* Đối với hiệu ứng Bevel Emboss: 

+ Depth: Độ cao của cạnh vát. 

+ Soften: làm mềm cạnh vát. 

Bảng Style: chứa các Layer Style có sẵn, muốn sử dụng các Style này ta chỉ việc 

nhấp chuột vào ô biểu tượng của Style cần dùng. Ta có thể tải thêm các Style có sẵn 

hoặc tự tạo ra các Style mới. 

 
Bảng Style. 
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Chương 3 Ứng dụng với Adobe Photoshop 

3.1 Hiệu chỉnh ảnh thẻ, ảnh chân dung 
B1. Mở File Ảnh 1 Begin > Phím F7 . Ngày 20 Chạp Bính Tuất 2006 utbinh 
đi dẩy Mã > Chọn Croop Tool , Width 10 cm – Height 15.2 cm – Resolution 
300 > Rê tạo vùng chọn Chân dung Ảnh 1 .(H1).  

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  
  

B2. Chọn Pen Tool , Thanh Options chọn Paths > Ctrl+  phóng to Ảnh dễ thao 

tác > Chấm từng điểm neo sát nhiều càng tốt để tạo đường Paths > Nối với 

điểm khởi đầu . 
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B3. Ctrl+J > Background > Chọn Gradient Tool >Thanh Options nhấp Menu > 

Chọn Simple > Chọn Blue > Chọn tiếp kiểu tô là Radial Gradient >  

Rê đỉnh Trái xuống Đáy Phải 1 cm > Đã có nền Gradient xanh kiểu Radial . 

Đổi màu Gradient và kiểu tô theo hướng dẫn trên , các số liệu theo hình 
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B4. Mở file ảnh có áo Vest như hình mẫu: 
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 Chọn Move Tool > Rê qua Anh 1 > Rê Layer 2 Áo Veste lên đỉnh Tab Layer > 
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3.2  Thiết  kế Album ảnh KTS 

Album ảnh được thiết kế dựa trên một tập hợp nhiều bức ảnh cùng chủ đề. Cách xử 

lý ảnh ở các bức ảnh đều sử dụng các công cụ và lệnh như nhau trong Photoshop. 

Dưới đây chúng ta sẽ tìm hiểu cách xử lý cho một bức ảnh cụ thể để áp dụng cho 

các bức ảnh trong album. 

Bước 1: Mở 2 bức hình nguồn, tôi mở 2 hình sau, 2 bức hình nguồn cần nên có độ 

phân giải cao  

 

 
 
Bước 2:  Dùng move tool để kéo bức hình cần ghép vào hình sẽ ghép  
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Bước 3:  Nhấn Ctrl+T để cân chỉnh kích thước của hình mới đưa vào 

 
 
Bước 4:  Đưa chế độ hoà trộn của layer trên về Multifly nhằm loại bỏ toàn bộ điểm 
ảnh sáng và chỉ nổi điểm ảnh tối 
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Bước 5:  Nhân đôi layer chứa hình người và chọn chế độ hoà trộn Normal, sau đó 
dùng công cụ xoá để xoá đi vùng ảnh trắng, có thể xoá đè lên vùng tóc vì vùng tóc 
đã được layer dưới hiển thị vì tóc màu đen 
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Bước 6:  Kết quả sau khi xoá 
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Bước 7:  Vào Image > Flatten Image để nhập các layer lại, sau đó cân chỉnh lại 
màu sắc bằng bất kỳ công cụ chỉnh ánh sáng nào. Sau đây tôi dùng Curves vì tôi 
thấy trên hình gốc có một số điểm ảnh choá sáng. 
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 Và đây là kết quả cuối cùng  
 

 
 

3.3  Phục chế ảnh cũ 
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- Dùng công cụ Lasso Tool (phím tắt L) để chọn những phần hình bị trầy xước, rách. 
- Vào menu Filter \ AKVIS \ Retoucher bấm vào nút Restore the selected area.  
- Sau đó bấm vào nút Apply 
- Dùng công cụ Smudge Tool (hình ngón tay phím tắt là R) để làm mịn các chỗ vừa 

xử lý, nên chọn mức Strength là 30% (Strength ở thanh công cụ dưới các menu). 
 
Đây là hình ảnh trước phục chế 
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Ảnh khi chọn những vùng cần xử lý bằng công cụ Lasso Tool 
  
  
  
 
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
 

- Dùng công cụ Smudge Tool (hình ngón tay phím tắt là R) để làm mịn các chỗ vừa 
xử lý, nên chọn mức Strength là 30% (Strength ở thanh công cụ dưới các menu). 
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3.4 Vẽ, thiết kế Poster 
- Thiết kế một logo là bước đầu tiên trong việc xây dựng Poster . Một mẫu 

logo đẹp sẽ để lại ấn tượng tốt. Bạn có muốn tự tay thiết kế logo theo ý 

tưởng của riêng mình? Bài viết này sẽ hướng dẫn các bạn thiết kế logo bằng 

phần mềm photoshop. 

Bây giờ chúng  ta sẽ tìm hiểu làm thế nào để thiết kế một logo đơn giản. 

 
 

Các bước thiết kế một logo cơ bản 

Bước 1: Tạo một file mới 

Hãy vào File -> New hoặc nhấn tổ hợp phím CTRL + N trong Photoshop. Chọn 

chiều rộng và chiều cao thích hợp cho thiết kế của bạn. Tôi muốn có một canvas 

lớn với width 1000px  và height  600px. Bạn luôn có thể thay đổi kích thước  

Canvas sau đó. 
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Bước 2: Tạo hình dạng cơ bản 

Để tạo hiệu ứng mà chúng ta muốn, chúng tôi sẽ tạo một chữ  'A' với hai hình 

chồng chéo như hình dưới đây: 
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Chúng ta sẽ sử dụng công cụ "Pen" để tạo ra hình dạng của chúng tôi. Đó là cây 

bút có hình dạng biểu tượng trên thanh công cụ bên trái. 

 

Bây giờ, tạo một layer mới. Đặt tên nó là Shape 1 . Chọn công cụ Pen, chọn 'hình 

dạng' trong các thuộc tính công cụ ở đầu trang. Chọn một màu đỏ tươi để điền vào 

(tôi đã sử dụng # ed1c24 ). 
 

 
 

 

Nó rất hữu ích để chuyển đổi trên lưới điện trong khi vẽ. Bạn vào View -> Show -

> Grid, hoặc nhấn tổ hợp phím CTRL + '. Tạo hình dạng như hình dưới đây: 

 
Đối với hình thứ hai, thay vì vẽ nó từ đầu, chúng ta có thể chỉ đơn giản là sao chép 

Layer Shape 1 và lật nó theo chiều ngang. 

 

Chọn hình dạng hiện tại trong cửa sổ lớp bên phải. Nhấp chuột phải vào nó và 

chọn "Duplicate Layer" Đặt tên layer mới Shape 2 bạn muốn. 
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Bây giờ chọn lớp nhân bản, vào Edit -> Transform Path -> Flip Horizontal 

Bạn sẽ có hình dạng dưới đây 
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Kéo nó trên bên phải để nó chồng lên hình đầu tiên hoàn hảo như trong những hình 

ảnh trên. 

Bước 3: Thay đổi màu sắc 

Từ khi chúng tôi muốn tạo ra một chồng chéo 'Origami' như hiệu quả, chúng tôi sẽ 

thực hiện một trong các lớp hình dạng của chúng tôi hơi tối hơn màu để tạo ấn 

tượng về chiều sâu. 

Double-click vào Shape 2 thumbnail trong cửa sổ Layers. Các cửa sổ lựa chọn màu 

sắc nên pop-up. 
 

 
 

Chọn một màu hơi sẫm hơn màu đỏ. Tôi chọn # b00309 

Trong khi bạn đang ở đó, kéo layer Shape 1 trên đầu trang của Shape 2 lớp trong 

cửa sổ Layers là tốt, mà hình 2 như vậy dường như là đằng sau Shape 1. 

Bước 4: Tạo Shadow 

Nhân đôi layer Shape 1 như mô tả ở trên. Đặt tên nó là Shadow lớp Thay đổi màu 

sắc của layer mới này thành màu đen (# 000000). Vào Filter -> Blur -> Gaussian 
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Blur. Chọn một bán kính 2,75 pixel. Hình ảnh của bạn sẽ trông như thế này : 

Bây giờ kéo Shadow lớp bên dưới Shape 1 trong cửa sổ Layers. Nhấp chuột phải 

vào bóng Layer và chọn "Create Clipping Mask" 



 51 

 
 

Logo hình ảnh của bạn bây giờ sẽ có hiệu ứng đổ bóng đẹp. 
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Bước 5: Thêm Text 

Bây giờ chúng ta sẽ thêm chữ vào logo của chúng tôi. Thật không may, việc lựa 

chọn font chữ mặc định của Windows là không chính xác quá lớn. Vì vậy, thay vì 

sử dụng phông chữ cũ như Arial, bạn có thể tìm kiếm trên Google Fonts và tải về 

một loạt các, phông chữ mới hiện đại. 

Đối với bài hướng dẫn này, tôi khuyên bạn nên tải Raleway . Đây chỉ là một sở 

thích cá nhân mặc dù. Bạn có thể chọn bất kỳ một trong số hàng trăm phông chữ 

miễn phí trên Google Fonts. Một số font  là: Open Sans, Roboto, Ubuntu, Exo, 

Lobster, Bevan 

Một khi bạn đã cài đặt font Raleway (trích xuất các tập tin zip tải về và nhấp đúp 

chuột vào font-name để cài đặt tự động), chúng sẽ xuất hiện trên công cụ 'Type' 

trong hộp công cụ và thêm văn bản của bạn. 

Tôi chọn Raleway với font-weight của 'bold' và một font-size của 200px. Hãy thử 

nghiệm với điều này nếu bạn muốn. 

Đặt văn bản bên dưới logo. Đối với một chút tác dụng phụ, thêm một bóng thả cho 

văn bản. Nhấp chuột phải vào layer text, chọn "Blending Options '. Trong cửa sổ 

hiện ra, chọn 'Drop Shadow' và chọn các thông số sau: 



 53 

 

Bước 6: Thêm một Gradient Background 

Đây là bước cuối cùng để cung cấp cho logo của chúng ta một chút tinh tế ấn 

tượng. 

Nhấp vào nút "Create New Fill hoặc Adjustment Layer " ở dưới cùng của cửa sổ 

Layers. 
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Chọn 'Gradient'. Trong cửa sổ hiện ra, chọn 'Radial' dưới Style. Hãy chắc chắn để 

kiểm tra các tùy chọn 'Đảo ngược' ở phía dưới. 

 
 

Bây giờ, nhấp đúp chuột vào màu gradient trong cửa sổ. Cửa sổ Gradient chỉnh sửa 

sẽ bật lên. Hãy lựa chọn các thiết lập màu sắc đến khi bạn ưng ý 
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Bước cuối cùng, kéo layer gradient của bạn dưới đây tất cả các lớp khác trong cửa 

sổ Layers, mà nên như thế này: 
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Logo của bạn bây giờ là hoàn tất! 

 


